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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP Compaq 2210b Notebook PC

Processors Intel® Core™ 2 Duo processors:

 T7800 2.6-GHz processor, 4-MB L2 cache, 800-MHz front side bus (FSB)

 T7700 2.4-GHz processor, 4-MB L2 cache, 800-MHz FSB

 T7500 2.2-GHz processor, 4-MB L2 cache, 800-MHz FSB

 T7300 2.0-GHz processor, 4-MB L2 cache, 800-MHz FSB

 T7100 1.8-GHz processor, 2-MB L2 cache, 800-MHz FSB

 Intel Celeron® M processors:

 Celeron M 540 1.86-Ghz processor, 2-MB L2 cache, 533-MHz FSB

 Celeron M 530 1.73-Ghz processor, 2-MB L2 cache, 533-MHz FSB

Chipset Northbridge: Intel GM965 with up to 800-Mhz FSB

 Southbridge: Intel ICH8M

Graphics Intel Unified Memory Architecture (UMA) graphics subsystem integrated with shared system
memory (dynamically allocated)

Panel 12.1-inch WXGA panel (1280 × 800)

 All display assemblies include 2 wireless local area network (WLAN) antennae

Memory 2 customer-accessible/upgradable memory module slots

 Supports dual-channel memory

 Supports up to 4 GB of system RAM

 PC2-5300, 667-MHz, DDR2

 Supports the following configurations:

● 4096-MB total system memory (2048 × 2, dual-channel)

● 3072-MB total system memory (2048 + 1024)

● 2560-MB total system memory (2048 + 512)

● 2048-MB total system memory (1024 × 2, dual-channel)

● 2048-MB total system memory (2048 × 1)

● 1536-MB total system memory (1024 + 512)
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Category Description

● 1024-MB total system memory (512 × 2, dual-channel)

● 1024-MB total system memory (1024 × 1)

● 512-MB total system memory (512 × 1)

Hard drives Supports 9.5-mm, 2.5-inch hard drives

 Customer-accessible

 Serial ATA

 HP 3D DriveGuard

 Supports the following drives:

● 200-GB, 4200-rpm

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

● 80-GB, 5400-rpm

Optical drives Fixed (removal of 1 screw required)

 Customer-accessible

 Parallel ATA

 12.7-mm tray load

 Supports no-optical-drive option

 Supports the following drives:

● DVD/CD-RW Combo Drive

● DVD-ROM Drive

Diskette drive Supports external USB diskette drive only

Microphone Integrated mono microphone

Audio Azalia audio

 2 speakers

Modem 56K V.92 1.5-inch data/fax modem with digital line guard

 Modem cable included

Ethernet Intel Broadcom 5787 10/100/1000 network interface card (NIC)

 S4/S5 wake on LAN: AC

 NIC power-down technology

Wireless Integrated WLAN options by way of wireless module:

 2 wireless antennae built into display assembly

 Support for no-WLAN option
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Category Description

 Support for the following WLAN formats:

● Intel 802.11a/b/g/n

● Broadcom 802.11a/b/g

● Intel 802.11a/b/g

● Broadcom 802.11b/g

● Intel 802.11b/g

 Integrated personal area network (PAN) options by way of Bluetooth®
module:

 Support for no-WPAN option

 Broadcom Bluetooth

External media card One Type I/II PC Card slot, supporting 16-bit and 32-bit (Cardbus) PC Card modules

 Media Card Reader supporting MMC and SD digital cards

Ports Audio-in (mono microphone)

 Audio-out (stereo headphone)

 S-Video-out

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (3)

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug/unplug
with auto-detect)

 Multi-pin AC power

Keyboard/pointing devices Spill-resistant 12.3-inch keyboard

 TouchPad with 2 TouchPad buttons

 Supports 1-way scroll

 Taps enabled as default

 Windows Vista® Hardware Start Button

Power requirements 65-W AC adapter with localized and pointing stick cable plug support (3-wire plug with
ground pin, supports 3-pin DC connector)

 8-cell, 2.55-Ah (73-Wh) Li-ion battery

 4-cell, 2.25-Ah (37-Wh) Li-ion battery

Security Security cable slot

 Integrated fingerprint reader

Operating system Preinstalled:

 Windows Vista® Business 32

 Windows Home Basic 32
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Category Description

 Windows® XP Professional

 FreeDOS (India and Thailand)

 FreeDOS (Thailand)

 Restore Media:

 Windows Vista Business 32

 Windows Vista Home Basic 32

 Windows XP Professional

 DRDVD XP

 DRDVD Vista

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module

 Optical drive

 WLAN module
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2 External component identification

Display components

Component Function

Wireless antennae (2)* Send and receive wireless signals to communicate with
WLANs.

*The antennae are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennae free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to your
country or region. These notices are located in Help and Support.

Display components 5



Top components
Pointing devices

Item Component Function

(1) TouchPad Moves the pointer and selects or activates items on the
screen.

(2) Left TouchPad button Functions like the left button on an external mouse.

(3) Right TouchPad button Functions like the right button on an external mouse.

(4) TouchPad scroll zone Scrolls up or down.

NOTE: This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to shut down
the computer.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
System and Maintenance > Power Options.

(2) Info button Launches Info Center, which enables you to open various
software solutions.

(3) Presentation button Starts the presentation feature.

(4) Wireless button Turns the wireless feature on or off, but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(5) Volume mute button Mutes and restores speaker sound.
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Item Component Function

(6) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume.

(7) HP Fingerprint Sensor (fingerprint reader) Allows a fingerprint logon to Windows, instead of a
password logon.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Lights

Item Component Function

(1) Wireless lights (2)† ● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Broadband
Wireless Module, and/or a Bluetooth® device, is on.

● Off: All wireless devices are off.

(2) Power lights (2)* ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.
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Item Component Function

(5) Volume mute light ● Off: Computer sound is on.

● On: Computer sound is off.

(6) Volume down light Blinking: The volume scroll zone is being used to decrease
speaker volume.

(7) Volume up light Blinking: The volume scroll zone is being used to increase
speaker volume.

*The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

†The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.
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Front components

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a WLAN
device, the HP Broadband Wireless Module, and/or a
Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Speakers (2) Produce sound.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television
audio.

(7) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.
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Left-side components

Item Component Function

(1) Power connector Connects an AC adapter.

(2) USB ports (2) Connect optional USB devices.

(3) RJ-45 (network) jack Connects a network cable.

NOTE: The RJ-45 (network) jack provides Gigabit Ethernet
functionality.

(4) RJ-11 (modem) jack Connects a modem cable.

(5) Optical drive Reads optical discs and, on select models, also writes to
optical discs.

(6) Optical drive light On: The optical drive is being accessed.
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Right-side components

Item Component Function

(1) ExpressCard slot (select models only) Supports optional ExpressCard/54 cards.

(2) Media Card Reader Supports the following optional digital card formats:
MultiMedia Card (MMC) and Secure Digital (SD) Memory
Card.

(3) USB port (select models only) Connects an optional USB device.

(4) S-Video-out jack Connects an optional S-Video device such as a television,
VCR, camcorder, overhead projector, or video capture
card.

(5) Internal microphone Records sound.

(6) External monitor port Connects an external VGA monitor or projector.

(7) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Bottom components

Item Component Function

(1) Hard drive bay Holds the hard drive.

(2) Vents (5) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) Memory module compartment Contains a memory module slot.

(4) Battery bay Holds the battery.

(5) WLAN module compartment Contains a WLAN module slot.

CAUTION: To prevent an unresponsive system, use only
a wireless module authorized for use in the computer by the
governmental agency that regulates wireless devices in your
country or region. If you install the module and then receive
a warning message, remove the module to restore computer
functionality, and then contact technical support through
Help and Support.

(6) Battery release latch Releases the battery from the battery bay.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Item Description Spare part
number

(1) 12.1-inch, WXGA display assembly (includes 2 WLAN antenna transceivers and
cables)

454004-001

 Display internal components

 Display bezel (includes nameplate) 455400-001

 Display inverter 454009-001

 Display hinges 454011-001

 Display enclosure (includes logo) 454398-001

(2) Switch cover (includes LED board and cable) 454006-001

(3) Keyboards (include keyboard cable)

 For use in Japan 454017-291

 For use in South Korea 454017-AD1

 For use in Taiwan 454017-AB1

 For use in Thailand 454017-281

 For use in the United States 454017-001

(4) Top cover (includes TouchPad and cable, and fingerprint reader board and cable) 453994-001

(5) RTC battery 449137-001

(6) Microphone (included in the Cable Kit, spare part number 454008-001. See Cable Kit on page 21 for more Cable
Kit information.)

(7) Speaker assembly 457906-001

(8) Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cables Kit, spare part number 454008-001. See
Cable Kit on page 21 for more Cable Kit information.

398393-002

 Plastics Kit (see Plastics Kit on page 22 for more Plastics Kit spare part information) 454010-001

(9a) ExpressCard slot bezel

(9b) WLAN module compartment cover

(9c) Memory module compartment cover

(9d) Hard drive cover

(10) Front LED board (includes front LED board cable) 453996-001

(11) System board (includes replacement thermal material) 453991-001

(12) Modem modules

NOTE: The modem module spare part kits do not include a modem module cable. The modem module cable is included
in the Cables Kit, spare part number 454008-001. See Cable Kit on page 21 for more Cable Kit information.

 For use in all countries and regions except Japan and Asia Pacific countries and regions 451403-001

 For use only in Japan and Asia Pacific countries and regions 449139-001

(13) ExpressCard assembly 457907-001
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Item Description Spare part
number

(14) Processors (include replacement thermal material)

 Intel Core 2 Duo processors (4-MB L2 cache, 800-MHz FSB):

 ● T7800 2.6-GHz processor 454016-001

 ● T7700 2.4-GHz processor 446894-001

 ● T7500 2.2-GHz processor 454015-001

 ● T7300 2.0-GHz processor 446892-001

 ● T7100 1.8-GHz processor (1-MB L2 cache) 446891-001

 Intel Celeron M processors (1-MB L2 cache, 533-MHz FSB):

 ● 540 1.86-GHz processor 454600-001

 ● 530 1.73-GHz processor 454599-001

(15) Heat sink (includes replacement thermal material) 453998-001

 Thermal Material Kit 445853-001

(16) Fan 453999-001

(17) Optical drives (include optical drive bezel and bracket)

 DVD/CD-RW Combo Drive 454333-001

 DVD-ROM Drive 454334-001

 Optical Drive Bezel/Bracket Kit (not illustrated) 454000-001

(18) Base enclosure (includes rubber feet) 453993-001

(19) Batteries

 8-cell, 73-WH 454002-001

 4-cell, 37-WH 454001-001

(20) WLAN modules

 Intel 802.11a/b/g/n WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-001

 ● For use in Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

 ● For use in Japan 441086-291

 Broadcom 802.11a/b/g WLAN modules:
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Item Description Spare part
number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia
and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

 ● For use in Japan 441075-291

 Intel 802.11a/b/g WLAN modules:

 ● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United
States, Uruguay, Venezuela, and Vietnam

448674-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

448674-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

448674-003

 ● For use in Japan 448674-291

 Broadcom 802.11b/g WLAN modules:

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia
& Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,

441090-002
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Item Description Spare part
number

Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St.
Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

 ● For use in Japan 441090-291

 Intel 802.11b/g WLAN module for use in Thailand 448675-004

(21) Memory modules (PC2-5300, 667-MHz, DDR2)

 2048-MB 417506-001

 1024-MB 414046-001

 512-MB 414045-001

(22) Hard drives (include hard drive bracket)  

 200-GB, 4200-rpm 454338-001

 160-GB, 5400-rpm 454337-001

 120-GB, 5400-rpm 454336-001

 80-GB, 5400-rpm 454335-001

 Cable Kit (not illustrated 454008-001
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Cable Kit

Item Description Spare part number

 Cable Kit: 454008-001

(1) Bluetooth module cable

(2) Modem module cable (includes RJ-11 jack)

(3) Microphone (includes receiver)
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 454010-001

(1) ExpressCard slot bezel

(2) WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(3) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(4) Hard drive cover (includes 2 captive screws, secured by C-clips)
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Item Description Spare part number

(5) Computer feet (4)

(6) Base enclosure screw covers (4 covers, 2 sizes)

Mass storage devices

Item Description Spare part number

(1) Hard drives (include bracket )

 200-GB, 4200-rpm 454338-001

 160-GB, 5400-rpm 454337-001

 120-GB, 5400-rpm 454336-001

 80-GB, 5400-rpm 454335-001

(2) Optical drives (include bezel)

 DVD/CD-RW Combo Drive 454333-001

 DVD-ROM Drive 454334-001
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Miscellaneous parts
Description Spare part number

65-W AC adapter 391172-001

Power cords:

For use in Australia 246959-011

For use in Japan 246959-291

For use the United States 246959-001

Screw Kit

● Phillips PM3.0×4.0 screw

● Phillips PM2.5×12.0 captive screw

● Phillips PM2.5×7.0 captive screw

● Phillips PM2.5×7.0 screw

● Phillips PM2.5×6.0 screw

● Phillips PM2.5×5.0 screw

● Phillips PM2.5×4.0 screw

● Phillips PM2.0×6.0 screw

● Phillips PM2.0×6.0 shoulder screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.5×6.0 screw

● Torx T8M2.5×5.0 screw

454014-001
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Sequential part number listing
Spare part
number

Description

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia

246959-291 Power cord for use in Japan

391172-001 65-W AC adapter

398393-002 Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cables Kit, spare part number 454008-001. See Cable Kit on page 21 for more Cable
Kit information.

414045-001 512-MB memory module (PC2-5300, 667-MHz, DDR2)

414046-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2)

417506-001 2048-MB memory module (PC2-5300, 667-MHz, DDR2)

441075-002 Broadcom 802.11a/b/g module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis,
St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-291 Broadcom 802.11a/b/g module for use in Japan

441082-001 Intel 802.11a/b/g module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El
Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441082-003 Intel 802.11a/b/g module for use in Australia, New Zealand, Pakistan, the People's Republic of China, and
South Korea

441082-291 Intel 802.11a/b/g module for use in Japan

441086-002 Intel 802.11a/b/g module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus,
the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland,
Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands,
Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore,
Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom,
and Uzbekistan
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Spare part
number

Description

441090-002 Broadcom 802.11b/g module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St.
Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

441090-291 Broadcom 802.11b/g module for use in Japan

445853-001 Thermal Material Kit

446891-001 Intel Core 2 Duo T7100 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

446892-001 Intel Core 2 Duo T7300 2.00-GHz processor (4-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

446894-001 Intel Core 2 Duo T7700 2.40-GHz processor (4-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

448674-001 Intel 802.11a/b/g module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El
Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

448674-002 Intel 802.11a/b/g module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus,
the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland,
Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands,
Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore,
Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom,
and Uzbekistan

448674-003 Intel 802.11a/b/g module for use in Australia, New Zealand, Pakistan, the People's Republic of China, and
South Korea

448674-291 Intel 802.11a/b/g module for use in Japan

448675-004 Intel 802.11b/g module for use in Thailand

449137-001 RTC battery

449139-001 Modem module for use only in Japan and Asia Pacific countries and regions

NOTE: The modem module spare part kits do not include a modem module cable. The modem module cable
is included in the Cables Kit, spare part number 454008-001. See Cable Kit on page 21 for more Cable Kit
information.

451403-001 Modem module for use in all countries and regions except Japan and Asia Pacific countries and regions
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Spare part
number

Description

NOTE: The modem module spare part kits do not include a modem module cable. The modem module cable
is included in the Cables Kit, spare part number 454008-001. See Cable Kit on page 21 for more Cable Kit
information.

453991-001 System board (includes replacement thermal material)

453993-001 Base enclosure (includes rubber feet)

453994-001 Top cover (includes TouchPad and cable, and fingerprint reader board and cable)

453996-001 Front LED board

453998-001 Heat sink (includes replacement thermal material)

453999-001 Fan

454000-001 Optical Drive Bezel/Bracket Kit

454001-001 4-cell, 37-WH battery

454002-001 8-cell, 73-WH battery

454004-001 12.1-inch, WXGA, display assembly

454005-001 Switch cover

454008-001 Cable Kit

454009-001 Display inverter

454010-001 Plastics Kit

454011-001 Display hinges (includes left and right display hinges)

454014-001 Screw Kit

454015-001 Intel Core 2 Duo T7500 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

454016-001 Intel Core 2 Duo T7800 2.6-GHz processor (4-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

454017-001 Keyboard for use in the United States

454017-281 Keyboard for use in Thailand

454017-291 Keyboard for use in Japan

454017-AB1 Keyboard for use in Taiwan

454017-AD1 Keyboard for use in South Korea

454333-001 DVD/CD-RW Combo Drive

454334-001 DVD-ROM Drive

454335-001 80-GB, 5400-rpm hard drive (includes hard drive bracket)

454336-001 120-GB, 5400-rpm hard drive (includes hard drive bracket)

454337-001 160-GB, 5400-rpm hard drive (includes hard drive bracket)

454338-001 200-GB, 4200-rpm hard drive (includes hard drive bracket)

454398-001 Display enclosure (includes 2 WLAN transceivers and cables and logo)
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Spare part
number

Description

454599-001 Intel Celeron-M 530 1.73-GHz processor (1-MB L2 cache, 533-MHz FSB, includes replacement thermal material)

454600-001 Intel Celeron-M 540 1.86-GHz processor (1-MB L2 cache, 533-MHz FSB, includes replacement thermal material)

455400-001 Display bezel (includes nameplate)

455585-001 Miscellaneous Display Kit

455586-001 Display Cable Kit

456226-001 Fingerprint reader board

457906-001 Speakers

457907-001 ExpressCard assembly
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 58).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 84 screws, in 15 different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Plastics Kit, spare part
number 454010-001. There are 4 rubber feet that attach to the base enclosure in the locations illustrated
below.
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Battery

Description Spare part number

8-cell, 2.55-Ah (73-Wh) Li-ion battery 454002-001

4-cell, 2.20-Ah (37-Wh) Li-ion battery 454001-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

200-GB, 4200-rpm hard drive 454338-001

160-GB, 5400-rpm hard drive 454337-001

120-GB, 5400-rpm hard drive 454336-001

80-GB, 5400-rpm hard drive 454335-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the four Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.

3. Lift the rear edge of the hard drive cover (2), swing it up and forward, and remove the cover. The
hard drive cover is included in the Plastics Kit, spare part number 454010-001.

4. Loosen the Phillips PM2.5×12.0 captive screw (1) that secures the hard drive to the computer.
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5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it
from the system board.

6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Memory module

Description Spare part number

2048-MB (PC2-5300, 667-MHz, DDR2) 417506-001

1024-MB (PC2-5300, 667-MHz, DDR2) 414046-001

512-MB (PC2-5300, 667-MHz, DDR2) 414045-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the memory module:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the memory module compartment
cover to the computer.

3. Lift the left side of the cover (2), swing it up and to the right, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 454010-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install a memory module.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Intel 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441086-003

● For use in Japan 441086-291

Broadcom 802.11a/b/g WLAN modules:

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, People's Republic of China, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

● For use in Japan 441075-291

Intel 802.11a/b/g WLAN modules:

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

448674-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,

448674-002
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Description Spare part number

Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 448674-003

● For use in Japan 448674-291

Broadcom 802.11b/g WLAN modules:

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

441090-002

● For use in Japan 441090-291

Intel 802.11b/g WLAN module for use in Japan 448675-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the WLAN module compartment cover
to the computer.
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3. Lift the right side of the cover, swing it up and to the left, and remove the cover.

4. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

5. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)

6. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

DVD/CD-RW Combo Drive 454333-001

DVD-ROM Drive 454334-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Torx T8M2.5×7.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the tab
to the right to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Keyboard

For use in: Spare part number For use in: Spare part number

Japan 454017-291 Thailand 454017-281

Korea 454017-AD1 The United States 454017-001

Taiwan 454017-AB1   

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the keyboard:

1. Turn the computer upside down, with the front toward you.

2. Loosen the three Phillips PM2.5×7.0 captive screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the rear edge of the keyboard (1) until it rests at an angle.
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6. Move the keyboard (2) toward the display until the tabs on the keyboard bottom edge disengage
from the top cover.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Switch cover

Description Spare part number

Switch cover (includes LED board and LED board cable) 454006-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the keyboard (see Keyboard on page 47).

Remove the switch cover:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the following:

(1) Two rubber screw covers. The rubber screw covers are included in the Plastics Kit, spare part
number 454010-001.

(2) Three Phillips PM2.5×7.0 screws.

(3) Five Phillips PM2.0×3.0 screws.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.
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5. Disconnect the LED board cable (1) from the system board.

6. Remove the switch cover (2).

Reverse this procedure to install the switch cover.
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Display assembly

Description Spare part number

12.1-inch, WXGA display assembly (includes WLAN antenna transceivers and cables) 454004-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 42).

6. Remove the keyboard (see Keyboard on page 47).

7. Remove the switch cover (see Switch cover on page 49).

Remove the display assembly:

1. Close the computer and turn it upside down, with the rear panel toward you.

2. Remove the Phillips PM2.5×7.0 screw (1) and Phillips PM2.5×5.0 screw (2) that secure the display
assembly to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Disconnect the display panel cable (1) from the system board.
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6. Remove the WLAN antenna cables (2) from the opening in the system board.

7. Remove the four Phillips PM2.5×6.0 screws (1) that secure the display assembly to the computer.

8. Lift the display assembly (2) straight up and remove it.
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9. If it is necessary to replace the display bezel or the display assembly internal components, remove
the six rubber screw covers (1) and the six Torx T8M2.5×6.0 screws (2) that secure the display
bezel to the display enclosure.

10. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

11. Remove the display bezel (3). The display bezel is available using spare part number
455400-001.

12. If it is necessary to replace the display inverter, release the inverter (1) as far as the display panel
cable and backlight cable allow.
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13. Disconnect the backlight cable (2) and the display panel cable (3) from the display inverter.

14. Remove the display inverter from the display enclosure. The display inverter is available using spare
part number 454009-001.

15. If it is necessary to replace the display hinges, remove the six Torx T8M2.5×5.0 screws (1) that
secure the display panel to the display enclosure.

16. Remove the display panel (2) from the display enclosure.

17. Remove the two Phillips PM2.0×4.0 screws (1) that secure the display hinges to the display panel.
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18. Remove the display hinges (2) from the display panel. The display hinges are available using spare
part number 454011-001.

Reverse this procedure to reassemble and install the display assembly.

Top cover

Description Spare part number

Top cover (includes TouchPad and cable, and fingerprint reader board and cable) 453994-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following:

(1) Two rubber screw covers. The rubber screw covers are included in the Plastics Kit, spare part
number 454010-001.

(2) Seven Phillips PM2.5×7.0 screws.

(3) Three Phillips PM2.0×3.0 screws.

3. Turn the computer right-side up, with the front toward you.

4. Disconnect the fingerprint reader board cable (1) from the system board.

5. Disconnect the TouchPad cable (2) from the system board.

6. Remove the two Phillips PM2.5×7.0 screws (3) and the two Phillips PM2.5×4.0 screws (4) that
secure the top cover to the computer.
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7. Lift the rear edge of the top cover (1) and swing it (2) up and forward until it rests at an angle.

8. Lift the top cover (3) straight up and remove it.

Reverse this procedure to install the top cover.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.
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2. Remove the RTC battery (2).

Reverse this procedure to install the RTC battery.
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Front LED board

Description Spare part number

Front LED board 453996-001

Before removing the front LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

Remove the front LED board:

1. Disconnect the front LED board cable (1) from the system board.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the front LED board to the base enclosure.
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3. Remove the front LED board (3).

Reverse this procedure to reassemble and install the front LED board.

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cables Kit, spare part number 454008-001. See Cable Kit
on page 21 for more Cable Kit information.

Description Spare part number

Bluetooth 398393-002

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)
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e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Remove the two Phillips PM2.0×4.0 screws (2) that secure the Bluetooth module to the system board.

3. Remove the module (3).

Reverse this procedure to install the Bluetooth module.

Speaker assembly

Description Spare part number

Speaker assembly 457906-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

Remove the speaker assembly:

1. Disconnect the speaker assembly cable (1) from the system board.

2. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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Microphone
NOTE: The microphone is included in the Cables Kit, spare part number 454008-001. See Cable
Kit on page 21 for more Cable Kit information.

Before removing the microphone, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

Remove the microphone:

1. Disconnect the microphone cable (1) from the system board.

2. Remove the microphone receiver (2) from the clip built into the base enclosure.
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Reverse this procedure to install the microphone.

System board

Description Spare part number

System board (includes replacement thermal material) 453991-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 40)

● WLAN module (see WLAN module on page 42)

● ExpressCard assembly (see ExpressCard assembly on page 67)

● Modem module (see Modem module on page 69)

● Fan (see Fan on page 71)

● Heat sink (see Heat sink on page 73)

● Processor (see Processor on page 75)

Remove the system board:

1. Remove the three Phillips PM2.5×6.0 screws (1) that secure the system board to the base enclosure.
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2. Loosen the captive standoff (2) on the fan that secures the system board to the base enclosure.

3. Flex the left side of the base enclosure (1) until the USB, RJ-45, and RJ-11 jacks (2) clear the openings
in the base enclosure.

4. Use the optical drive connector (1) to lift the left side of the system board (2) until it rests at an angle.

5. Remove the system board (3) from the base enclosure by pulling it away at an angle.

Reverse the preceding procedure to install the system board.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly 457907-001

Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

h. System board (see System board on page 65)

Remove the ExpressCard assembly:

1. Turn the system board upside down, with the left side toward you.
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2. Remove the four Phillips PM2.0×6.0 screws that secure the ExpressCard assembly to the system
board.

3. Turn the system board right-side up, with the left side toward you.

4. Remove the ExpressCard assembly from the system board.

Reverse this procedure to install the ExpressCard assembly.
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Modem module
NOTE: The modem module spare part kits doe not include a modem module cable. The modem module
cable is included in the Cables Kit, spare part number 454008-001. See Cable Kit on page 21 for more
Cable Kit information.

Description Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions 451403-001

For use only in Japan and Asia Pacific countries and regions 449139-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

h. System board (see System board on page 65)

Remove the modem module:

1. Turn the system board upside down, with the rear edge toward you.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.
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3. Disconnect the modem module (2) from the system board by lifting it straight up.

4. Remove the modem module and modem module cable.

Reverse this procedure to install the modem module and modem module cable.
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Fan

Description Spare part number

Fan 453999-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

h. System board (see System board on page 65)

Remove the fan:

1. Turn the system board upside down, with the rear edge toward you.

2. Disconnect the fan cable (1) from the system board.

3. Remove the three Phillips PM2.0×4.0 screws (2) that secure the fan to the heat sink.
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4. Remove the fan (3) from the heat sink.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Heat sink

Description Spare part number

Heat sink (includes a heat sink clip and replacement thermal material) 453998-001

Thermal Material Kit 445853-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

h. System board (see System board on page 65)

i. Fan (see Fan on page 71)

Remove the heat sink:

1. Remove the two Phillips PM2.0×6.0 shoulder screws (1) that secure the heat sink and the heat sink
retention clips to the system board.

2. Remove the heat sink retention clips (2) by sliding them to the left.
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3. Remove the heat sink (3) by lifting it straight up.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to detach the
assembly.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
(3), the processor (2), and graphics subsystem component (4) on the system board each time the heat
sink is removed. Thermal material is included with all system board, heat sink, and processor spare part
kits, and is also available in the Thermal Material Kit, spare part number 445853-001.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material. The Thermal Material Kit is
also available using spare part number 445853-001.

Description Spare part number

Intel Core 2 Duo processors (4-MB L2 cache, 800-MHz FSB)

T7800 2.6-GHz processor 454016-001

T7700 2.4-GHz processor 446894-001

T7500 2.2-GHz processor 454015-001

T7300 2.0-GHz processor 446892-001

T7100 1.8-GHz processor 446891-001

Intel Core Duo processors (2-MB L2 cache, 667-MHz FSB)

T5450 1.66-GHz processor 454598-001

T5250 1.50-GHz processor 455399-001

Intel Celeron-M processors (1-MB L2 cache, 533-MHz FSB)

540 1.86-GHz processor 454600-001

530 1.73-GHz processor 454599-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Hard drive (see Hard drive on page 38)

b. Optical drive (see Optical drive on page 45)

c. Keyboard (see Keyboard on page 47)

d. Switch cover (see Switch cover on page 49)

e. Display assembly (see Display assembly on page 51)

f. Top cover (see Top cover on page 55)

g. Bluetooth module (see Bluetooth module on page 61)

h. System board (see System board on page 65)
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i. Fan (see Fan on page 71)

j. Heat sin (see Heat sink on page 73)

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned with
the triangle (4) embossed on the processor slot.

Reverse this procedure to install the processor.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is
not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you restore
the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup by
turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions available
in Embedded Security for ProtectTools. For more information, refer to the
ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase cycles
from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system or on any optional
MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette drive,
or optical drive connected by a USB port to the computer or to an optional
docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code execution,
which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.
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Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Length 30.6 cm 12.01 in

Width 22.5 cm 8.86 in

Height (front to rear) 2.8 to 3.3 cm 1.10 to 1.29 in

Weight

Equipped with 8-cell battery and optical drive 2.12 kg 4.67 lbs

Equipped with 4-cell battery and optical drive 1.92 kg 4.23 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 65 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration
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 Metric U.S.

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

12.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +120/–40° vertical (typical)
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Hard drive specifications
 200-GB* 160-GB* 120-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 390,700,850 312,560,640 234,420,480 156,280,320

Disc rotational speed 4200 rpm 5400 rpm 5400 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications
may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM,
CD-ROM XA, MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW),
CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 μm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2),
CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 μm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws used in the computer. All
screws listed in this section are available in the Screw Kit, spare part number 454014-001.

Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 11 4.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Where used: 4 screws that secure the display hinges to the display panel

Where used: 2 screws that secure the Bluetooth module to the system board

Where used: 3 screws that secure the fan to the heat sink
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Silver 7 5.0 mm 2.0 mm 4.5 mm

Where used:

(1) Four captive screws that secure the hard drive cover to the computer

(2) Two captive screws that secures the memory module compartment cover to the computer

(3) One captive screw that secures the WLAN module compartment cover to the computer
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Phillips PM2.5×12.0 captive screw

Color Quantity Length Thread Head diameter

Silver 1 12.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the hard drive to the computer
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Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 6 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board
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Where used: 2 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the modem module to the system board
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Phillips PM2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 14 7.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Three screws that secure the switch cover to the computer

(3) One screw that secures the display assembly to the computer

100 Chapter 7   Screw listing



Where used: 7 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the top cover to the base enclosure
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Phillips PM2.5×7.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 7.0 mm 2.5 mm 5.0 mm

Where used: 3 captive screws that secure the keyboard to the computer
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 10 3.0 mm 2.0 mm 4.5 mm

Where used: 5 screws that secure the switch cover to the computer

Where used: 3 screws that secure the top cover to the base enclosure
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Where used: 2 screws that secure the front LED board to the base enclosure
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Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 5 5.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display assembly to the computer
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Where used: 4 screws that secure the display assembly to the computer

Torx T8M2.5×6.0 screw

Color Quantity Length Thread Heat diameter

Black 6 6.0 mm 2.5 mm 5.0 mm

Where used: 6 screws that secure the display bezel to the display assembly
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Torx T8M2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 6 5.0 mm 2.5mm 5.0 mm

Where used: 6 screws that secure the display panel to the display enclosure
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Phillips PM2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 3 6.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the system board to the base enclosure
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 4 6.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the ExpressCard assembly to the system board
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Phillips PM2.0×6.0 shoulder screw

Color Quantity Length Thread Head diameter

Silver 2 6.0 mm 2.0 mm 5.0 mm

Where used: 2 shoulder screws that secure the heat sink to the system board
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8 Backup and recovery

Backup and recovery in Windows Vista
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL (purchased
separately). The discs you use will depend on the type of optical drive installed in your computer.
Because DVDs store more information than CDs, DVDs and DVDs with double-layer (DL) support
reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup & Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.
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With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.
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To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.

Backup and recovery in Windows Vista 113



Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your full
factory image if you experience system failure or instability. HP Backup & Recovery Manager works
from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL (purchased
separately). The discs you use will depend on the type of optical drive installed in your computer.
Because DVDs store more information than CDs, DVDs and DVDs with double-layer (DL) support
reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup and Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the
system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events
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When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy them
to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.
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4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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S-Video-out

Pin Signal

1 S-VHS color (C) signal

2 Composite video signal

3 S-VHS intensity (Y) signal

4 S-VHS color ground

5 TV-CD

6 S-VHS intensity ground

7 Composite video ground
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part

number 24,  25
antennae

locations 5
antennae, disconnecting 44
audio, product description 2
audio-in jack
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location 11
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B
backing up 111,  117
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files and folders 112,  118
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modifications made to the
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base enclosure screw cover,
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removal 37
spare part numbers 18,  27, 
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battery bay 14
battery latch 14
battery light 9,  11
Bluetooth module
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spare part number 17,  25, 
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Bluetooth module cable,
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boot options 81
boot order 81
bottom components 14
buttons

info 7
power 7
presentation 7
TouchPad 6
volume mute 7
wireless 7

C
Cable Kit
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cables, service considerations 30
chipset, product description 1
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components
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buttons 7
display 5
fingerprint reader 7
front 11
keys 8
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lights 9
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right-side 13
switch 7
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computer feet
illustrated 23
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spare part number 36

Computer Setup
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File menu 79
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System Configuration menu 81
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computer specifications 83
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power 12
service considerations 30

creating recovery points 114, 
120

D
Diagnostics menu 80
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display bezel

removal 53
spare part number 17,  53

display bezel, spare part
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Display Cable Kit, spare part
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display enclosure, spare part

number 27
display hinge
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display inverter
removal 53
spare part number 17,  27, 

54
display panel

product description 1
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display specifications 84
drive light 9,  11
DriveLock password 80
drives

boot order 81
preventing damage 30

DVD-ROM Drive
precautions 30
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spare part number 18,  23, 
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specifications 87
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E
electrostatic discharge 31
esc key 8
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ExpressCard assembly
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ExpressCard slot 13
external media cards, product

description 3
external monitor port
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pin assignments 124

F
fan

removal 71
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illustrated 23

locations 36
spare part number 36

File menu 79
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spare part number 28
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front components 11
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function keys 8
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graphics, product description 1
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hard drive
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specifications 85

hard drive backup 113,  119
hard drive bay 14
hard drive bracket, removal 39
hard drive cover

illustrated 22
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hard drive recovery 115,  121
hard drive test 80
headphone jack

location 11
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heat sink
removal 73
spare part number 18,  27, 

73
hinge

removal 54
spare part number 27,  55

HP Fingerprint Sensor 8

I
I/O address specifications 90
info button 7
interrupt specifications 89

inverter
removal 53
spare part number 27

J
jacks

audio-in 11
audio-out 11
headphone 11
microphone 11
modem 12
network 12
RJ-11 12
RJ-45 12
S-Video-out jack 13

K
keyboard

product description 3
removal 47
spare part numbers 17,  27, 

47
keypad keys 8
keys

esc 8
fn 8
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keypad 8
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Windows logo 8

L
LAN Power Save 81
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(USB) 77,  81
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drive 9,  11
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volume up 10
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M
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memory map specifications 92
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product description 1
removal 40
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40
memory module compartment 14
memory module compartment cover

illustrated 22
removal 40

microphone
illustrated 21
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